1. Postprocess Reference

Menu:

Postprocess ► Start

Nowadays there exists two different post process graphical user interfaces (GUI) to be used in our programs. On the one hand, the traditional GiD post process can be opened when selecting the menu option. It should be emphasized that more information about the commonly used GiD post process can be found both on GiD Help menu and on GiD support website. On the other hand, it is now possible to use a CompassLIB post process GUI perfectly integrated on a pane with a compact tree shape, which adds additional capabilities to the traditional GiD post process. Therefore, this post process couples all the features on a pane, which makes easy its management. Furthermore, it takes advantages of all the utilities described in Special features. This manual describes the relevant aspects of the new post process graphical user interface (GUI), which allows to set all the post process configuration preferences. To access the Tdyn built-in postprocess the following main menu command’s sequence can be invoked:

Postprocess ► Start traditional post

Postprocess ► Start

In order to toggle between pre and postprocess the following icon in the main Tdyn toolbar must be pressed:

Main Tdyn toolbar icon to be used to toggle between pre and postprocess

The post process GUI is located by default at the left side of the program screen, when selecting the menu option. It should be noted that some utilities could be chosen in the contextual menu, when clicking on the right mouse button. Moreover, other post process tools are available in the 'Postprocess' menu for creating cut planes or isosurfaces.

Postprocess ► Open GUI

Once inside the post processing, all the visualization features and management options of the prepossessing section are still available: Zoom, Rotate (Rotate screen/object axes, Rotate trackball, etc.), Pan, Redraw, Render, Label, Layer, etc.

NOTE 1: Double clicking the red title bar called ‘Postprocess’, then the post process window will be deintegrated from the main window. To recuperate the original window integrated do the same again.

NOTE 2: It should be important to note that it is necessary to choose results file 'binary 2' format in data tree preferences to be able to read the results successfully by the CompassLIB post processing, whereas 'binary 1' format is used by the traditional GiD post process. If 'binary 2 and mesh' is selected, then GiD mesh is also written. The 'ASCII' format also allows to read the results in the CompassLIB post processing GUI.

The post process contextual menu can be shown by clicking on the right mouse button:

• Special features
• Postprocess menu
• File menu
• Postprocess data tree

1.1. Postprocess data tree

The main postprocess window couples various sets of options, such as animations control, meshes, results or preferences selectors. In this way, each set of these options can be opened or minimized by pressing on its own button at the top of window.
Moreover, there is a grey button in each selector that closes, opens or turns it into a button.

These sets of options are described as follows:

- Animations control
- Meshes selector
- Results selector
- Preferences selector
- Contextual menu

1.1.1. Animations control

Animations are integrated in the basic Post process GUI as a movie player, which allows to create animations of the current results view.

The three buttons under the slide bar are self-explanatory: ‘rewind’, ‘play/pause’ and ‘forward’ the animation.

Moreover, clicking on the slide bar then the animation rewinds or forwards to the selected time. Notice that it is possible to repeat an animation with the check-button ‘Repeat’.

Note:

- Save animation opens a window allows to export the animation to AVI, MPEG or other video formats.

The procedure recommended to export to standard video format is explained below:

1. Define properties as name, type, delay, etc... Save redraws must be set.

2. Click button to start to save the animation.

3. Click button to start animation.

4. Click button to finish and close animation file.

A combo box allows to select a specific step and view animation preferences.

- If analysis is static, then program allows to calculate automatically some interpolated time steps. This option is available for Vibrations mode results too.
- The limits can be fixed along the animation, with automatic limits or defining both maximum and minimum limits in the results selector.

1.1.2. Meshes selector

This tool splits a complex mesh into separate pieces. In this way, it is possible to view only some meshes and to hide others. It is useful for making easier the visualization of selected meshes in
the graphical window. All the meshes available for the particular case are listed.

<table>
<thead>
<tr>
<th>Mesh name</th>
<th>Color</th>
<th>Display style</th>
<th>Line width</th>
<th>Transparent</th>
<th>Boundary conditions</th>
<th>Outline</th>
</tr>
</thead>
<tbody>
<tr>
<td>All meshes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Particular mesh 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Particular mesh 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Particular mesh 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Particular mesh 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Particular mesh 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Particular mesh 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Particular mesh 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Particular mesh 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Particular mesh 9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Particular mesh 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Several configurations are available:

- **On/Off**: Mesh visualization.
- **Display style**: Change the visualization style between the following options available:
  - Render
  - Render with border
  - Render and mesh
  - Mesh
  - Borders
- **Line style**: it is possible to draw shells and beams with real section.

- **Transparent**: Give surface transparency
- **Boundary conditions**: it draws the selected mesh as boundary conditions. For example, in the previous figure, **Fixed constraints Auto1** mesh is drawn as **Boundary conditions**.

1.1.3. **Results selector**

From this window it is possible to draw all calculated results using different type of visualizations (Vectors or Contour Fill).

In the case of **Vectors**, then once a result is chosen, the program will display its nodal vectors.

**Contour Fill** allows the visualization of colored zones, in which a variable or a component changes between two predefined values.
It is possible to fix maximum and minimum limits for the color scale, which can also be calculated automatically for the active meshes or for all the meshes. The following figure shows controls to define limits for the color scale and the contextual menu that allows to recalculate the limits.

**Contextual menu**

The most important options availables in the contextual menu are:

- **Legend colors**: It allows to define the colors scale for contour fill results.
- **Multiple results**: It transform the Results selector to make possible to choice more than one result to be shown.

**1.1.4. Preferences selector**

Several configuration options can be managed from this window, in both basic or advanced usage:

- **Basic**: For common operations like view deformation, draw labels, etc.
- **Advanced**: Displays preference options that are not modified very often.

Notice that the advanced preferences can only be shown when **All preferences** is set.
Deformed

Meshes can be deformed according to a vector result and a factor. When doing this, all results are drawn on the deformed meshes.

- **Draw**: if it is activated, then the free surface will be deformed.
- **Adimensional Factor**: if it is activated, then the free surface visualization is not real and the optimum visualization will be used.
- **Factor**: factor which multiplies the free surface representation. If factor = 1 and adimensional factor option is not checked, the visualization will be real.
- **Draw original**: it draws the original surface.
- **Result**: a vector result must be chosen. This result is used to show the free surface deformed. If this result contains more than one step, it is possible to animate the mesh deformation using the Animations control.

Below, an example of deformation is shown:

Multiple vector results can be used to deform different sets of meshes. This is specialy useful in Coupled Seakeeping-Structural analyses, since it is possible to select a result for fluid domain, and another for body domain.

As it is shown in the following figure, two results are selected to deformed both meshes, free surface and shell.

If different results related to the same mesh are selected, only the first chosen result is used to deform the mesh.

Cuts

Then preferences related to cut planes are explained:

- **Auto extend cuts**: when creating a cut over one surface, the cut line extends as much as possible. If cut plane is created using menu option, the cut line is extended regardless of this preference. However, if cut plane is create using the contextual menu, then the cut line is extended depending on this preference.
- **Cuts on boundaries**: if selected, the cuts on volumes will be lines on the boundary of the volume.

Example of cut with Cuts on boundaries set off

Example of cut with Cuts on boundaries set on

- **Auto transparent**: When creating a cut over one surface or volume, the surface or volume is set automatically to transparent.
- **Cut type**: This option defines the way that a plane cuts the set of active meshes:
  - **Connected elements**: Only are considered the element under the cursor and elements connected to it, without crossing aristes.
  - **Mesh**: Only are considered the elements that belongs to the mesh under the cursor.
  - **All**: The plane cuts all active meshes.

See Create cut plane.

Flow patterns

Some preferences can be configured for flow patterns.

- **Fluid velocity**: this is the most important preference related to flow patterns. It makes possible to choose a fluid velocity result necessary for creating flow patterns. Postprocess tries to find it, but if it is not possible, then user will have to do it. If there is not any fluid velocity result chosen, flow patterns will not be able to be created.
- **Fluid density**: It makes possible to choose a fluid density result. If there is not any fluid density result chosen, a fix density value must be defined in the particle tracking window.
- **Resolution**: It is the number of points to be drawn for all flow patterns. Between each pair of points, a straight line will be drawn. Therefore the higher resolution, the smoother the patterns will be. When it is changed, all flow patterns will be recalculated and redrawn using the new value.
1.2. Postprocess menu

1.2.1. Start & End
Menu:
For starting postprocess:
Postprocess ► Start
For starting traditional postprocess:
Postprocess ► Start traditional post
For ending postprocess:
Postprocess ► End

Toolbar: ☐ Toggle pre/postprocess

For postprocessing a model, it must be opened (ProjectName.gid), and then menu option can be selected or pre/post process toolbar button can be clicked. Then the results files will be loaded automatically if they exist.

Postprocess ► Start
Postprocess can open results file in ASCII or Binary2 format.

1.2.2. Open GUI
Menu:
Postprocess ► Open GUI

Toolbar: ☐

It shows the Postprocess data tree. The toolbar button shows the Postprocess data tree if it is hidden and hides if it is visible.

1.2.3. Clear
Menu:
Postprocess ► Clear
It removes all postprocess meshes, all results and other elements as information boxes.

1.2.4. Create cut plane
Menu:
Postprocess ► Create cut plane
This menu option allows to cut a volume or a surface. It is possible to define the cut plane by three ways:

- **In screen**: picking two points in the screen a line will be created. The plane will contain this line. If this option is used, it must be chosen to use global axis as a normal vector to the cutting plane, or chosen the cutting plane is orthogonal to the current view.
- **Three points**: the cut plane will be defined by three points.
- **Two points**: the cut plane will contain the two defined points and will be orthogonal to current view.

1.2.5. Create isosurface
Menu:
Postprocess ► Create isosurface
This option draws a surface or a line passing through all the points which have the same selected result's value inside a volume mesh, or surface mesh. For doing it, a result must be chosen and a value must be indicated to create a isosurface.

1.2.6. Create flow patterns
Postprocess allows to create flow patterns when there are fluid results. At least, it is necessary a fluid velocity result, but there
can be fluid density result too.

There are three types of flow pattern that can be created. Following, these three types are described.

**Types**

**Streamline**

**Menu:**

*Postprocess ➤ Create flow patterns ➤ Streamline*

Streamlines are a family of curves that are instantaneous tangent to the velocity vector of the flow. These show the direction a fluid element will travel in at any point in time.

![Example of streamlines at 0.5 seconds](image)

![Example of streamlines at 4.5 seconds](image)

**Pathline**

**Menu:**

*Postprocess ➤ Create flow patterns ➤ Pathline*

Pathlines are the trajectories that individual fluid particles follow. These can be thought of as a “recording” of the path a fluid element in the flow takes over a certain period. The direction the path takes will be determined by the streamlines of the fluid at each moment in time.

![Example of pathlines](image)

**Particle Tracking**

**Menu:**

*Postprocess ➤ Create flow patterns ➤ Particle tracking*

Particle tracking is the observation of the motion of individual particles within a fluid. Below an example of particles tracking, which have used the following parameters, is shown:

- Average of particles volume: 1 mm³
- Standard deviation of particles volume: 0.1 mm³
- Average Drag coefficient: 0.1
- Density of particles: 2000 kg/m³
- Density of fluid: 1000 kg/m³

**Creation and management**

It is possible to draw flow patterns in two ways:

1. Select a mesh with the right button of the mouse and flow pattern option of contextual menu. The selected mesh must be the fluid domain or be related to the fluid domain (for example the inlet). If the chosen mesh is the fluid domain and it is plane, it must be in the Z plane.

2. Selecting the menu option . This menu option allows to choose the type of flow pattern, streamline, pathline or particle tracking.

**Postprocess ➤ Create flow patterns**

A pane placed in the postprocess data tree allows to configure the flow pattern:

- **Single particle:** a flow pattern of a particle will be drawn. If the flow pattern tool is selected by the contextual menu, the initial position of the particle will be the point where the mesh was selected. The initial coordinates are shown in the frame when this option is selected and it can be changed using the button at the right of the coordinates. The coordinates units are the same of the mesh ones. On the other hand, if the flow pattern tool is selected by the menu, the particle coordinates must be selected using the button.

- **Area:** this option allows to create an area filled of particles. For using this option, a plane mesh must be selected (for example the inlet or a cut mesh). If flow pattern tool is selected using the contextual menu, the selected mesh will be used for creating the filled area of particles. If the menu is used, a mesh must be selected using the button at the right of the Plane mesh name. A boundary square around the mesh is calculated and it is filled of particles. The spacing between particles must be defined in the frame. The unit of the spacing is the same of the mesh one.

The next selector allows to choose the type of flow pattern to create. Although a type of flow pattern was selected using the menu, it is possible to change the type of flow pattern using this selector.

According to the type of flow pattern different options are available:

- **Streamline:** a step time must be chosen among all steps calculated by Tdyn.
- **Pathline:** there are not more options.
- **Particle Tracking:** there are three groups of parameters:
  - **Particle parameters:** if Single particle option is selected, the particle parameters will be:
    - Volume
    - Density
    - Drag coefficient
  - Area parameters: if Area option is selected, the particle parameters will be:
Volume average of the particles

- Standard deviation
- Density
- Drag coefficient average

The volume of each particle will be a random number from a Gauss distribution, and its drag coefficient will be calculated according to its volume and the drag coefficient average.

- Bounce: If this option is selected, particles will bounce off the mesh limit.

- Fluid density:
  - Use density result: if there is a fluid density result selected in preferences (see Annex II: About the postprocess results file) Use density result can be selected or not. If not, Use density result cannot be selected. If it is unselected, a fluid density value must be defined. These values will be used for all particle tracking, thus it is strongly recommended to define these values for the first flow pattern and not to change them during all session.

- Initial Velocity:
  - Use fluid velocity: if this option is selected the initial velocity of the particles will be the fluid velocity in their initial positions. It not, initial velocity of particles has to be defined by the user. These values will be used for all particle tracking therefore it is strongly recommended to defined these values for the first flow pattern and not to change them during all session.

When all parameters are configured, the flow pattern is created. New point meshes are created for pathlines and particle tracking and for each step of streamline selected. Moreover, new results of displacement and velocity are created using the same classification.

There are some preferences related to flow patterns in Preferences selector. See Flow patterns preferences.

1.2.7. Copy mesh

Menu:

Postprocess ► Copy mesh

Copy mesh allows to copy a mesh, a group of meshes or a set of elements of a mesh and apply a translation or symmetry to copied elements.

The new meshes inherit the results of the original meshes.

This command is very useful when the model used for calculating the results is a half or a fourth of the real model, and it is necessary to show the results of the complete model.

For example, the following model is calculated using the half of the real model.

However, it is required to show the results of the complete
model. Therefore, both meshes are copied and a symmetry movement is applied. Below, the imported meshes from preprocessor (green) and the copied meshes (red).

If a result is shown, it can see how the new meshes have inherited the results.

1.2.8. Mesh information

Menu:
Postprocess ▶ Mesh information

This command shows information of the following entities:
- Point
- Node
- Element
- Minimum and maximum result
- Mesh

If the selected entity type is Point, Node, Element or Minimum and maximum result, the most important information options are:
- Signal: it is useful to find an entity in the screen.
- Information box: an information box is shown with information of the entity as its position or its result value (if a result had been selected before using this option).
- Detailed information: more information of the selected entity can be show with this option, for example, the area or the volume of a mesh.

Contextual menu
If an element of a mesh (beam, shell or solid) is selected with the right button of mouse, the contextual menu will have an option () for copying meshes.

Mesh ▶ Copy
Rotation center:

Time graph: if the performed analysis is dynamic or nonlinear, this option creates a graph with the selected result evolution in a point, node, element or the minimum and maximum result.

Contextual menu allows to modify physical appearance of the graph, export and import. Advanced menu has several options and one of them allows to calculate Fourier transform of the time graph.

If menu option of Fourier transform is selected a dialog window with parameters to configure graphs appears.

Fourier transform will calculate from X initial value to first change of X increment, since it is possible to calculate Fourier transform if X increment is constant. When OK is pressed, a new graph with Fourier transform is created.

If the entity type is a Mesh, the most important information options are:

- List entities: it allows to create lists of nodes (coordinates of all nodes), elements, or result value of all nodes.
- Mesh quality:
- Hide elements: it allows to hide a selected group of elements. When this option is closed, then the hidden elements are shown another time.
- Memory information: it shows memory information of all meshes.

Contextual menu

If an element is selected with the right button of the mouse, contextual menu will have several options for knowing mesh information.

- Point information: It gives an information box about mesh entities and results when pressing on a point (data about the point and the result over it). Moreover, more detailed information can be shown when clicking on the box, also data on nodes and Gauss points, integrations over sets (both in global and local axes), local axes drawing, etc. For surfaces, local axes will have z' axe as normal. For lines, x' axe will be tangent to line. For line cuts, z' axe will also be normal to surface.
- Node information: It gives information about the coordinates of the selected node.
- It gives information about the selected mesh like Detailed information does.

Mesh ➔ Mesh information

1.2.9. Create text box

Menu:

Postprocess ➔ Create text box

A text box is shown at the bottom of the screen with the selected combination loadcase, result and, if it is possible the time step or load step.
1.2.10. Frequencies

Menu:
Postprocess ▶ Frequencies

This menu option is available in frequency analysis and it opens a window that shows the frequencies and modal mass calculated previously.

1.2.11. Computer animations tool

Once a post process results file is loaded and the 'Postprocess-Start' menu option has been selected, some animation templates are available in the 'Postprocess-Computer animations' menu.

It is important to note that the ‘animations’ folder of the installation directory offers various default template files in XML format (*.xml), which are provided to be used for creating new animations automatically. Furthermore, it is possible to add new template files into the ‘animations’ folder of the installation directory for designing special animations in other particular models.

Each animation provided can be modified both in the settings animation window and in the GUI, which is located at the left side of the screen.

A settings animation window can be set for Seakeeping analysis, as follows:

- Animate: Play the animation.
- Body movements file: Select a post process body movements results file for seakeeping analysis (*.BodyMovements.res).
- Body mesh file: Select a structure mesh file (*.msh)

A settings animation window can be set for a wind turbine analysis, as follows:

- Animate: play the animation.
- Rotate blades: Helices can be rotated or not.
- Mast height: define the height from the top of the last station to the center of the blades.
- Height free surface: Height of the free surface in the case of a seakeeping analysis.
- Postprocess mesh file mast + motor + blades (.post): select a postprocess mesh file of mast + motor + blades
Body movements file: select a postprocess body movements results file for Seakeeping analysis (*.BodyMovements.res).

- **Body mesh file**: select a structure mesh file (*.msh).
- **Point**: select a point in mesh located at the top of the last station to add there both the mast and the helices defined by default.

It is also possible to change the settings of each animation in the GUI and to apply them when clicking on the 'Postprocess-Refresh' menu option.

**Animation template file**

New template files in XML format (*.xml) can be added to the 'animations' folder of the installation directory for designing special animations. Therefore, it will be necessary to edit an animation template file and to call it as usually using the 'Postprocess-Computer animations' menu or using the post process menu option.

**File ▶ Import ▶ Animation files**

In general, the animation template files use the following tags:

- **<title>**

  The `<title>` tag defines the animation's name.

  **Syntax:**

  `<title>Title</title>`

  **Parameters:** Do not have.

- **<include>**

  Set the post process result files to be loaded by the animation. The file types could be one of the following:

  - **<geom_part>**

    - **gid_result**: results file which contains the free surface movements.

    - **tabular_data**: results file which contains the object movements present in the scene.

    **Syntax:**

    `<include xlink:href="cylinder.post" type="gid_result" create_geom_parts="1" />`

    **Parameters:**

    - **xlink:href="example_name.post"**: results file name. The file must be in the same path as the XML file.

    - **Type**: file type. Two possibilities are possible:

      - **Gid_result**: free surface results file which extension is "*.POST".

      - **Tabular_data**: free surface movements results file which extension is "*.BodyMovements.res".

      - **Create_geom_parts**: indicates if the program must import all the meshes present in the .POST file. Values between 0 or 1 for false and true respectively. It couples the different parts of the mesh to work with them.
When the 'create_geom_parts=0' parameter is present in the <INCLUDE> tag, the objects must be include into the scene manually.

Syntax:

```
schedule of the task
<geom_part
  n="free"
  pn="free"
  source="mesh,Free surface Auto1"
  color="blue"/>
```

Parameters:

- **n**: Object name.
- **pn**: short name.
- **source**: Mesh or meshes to construct the object.
- **color**: Object color in the scene.

**<variable>**

Define a variable and its value.

Syntax:

```
<variable
  n="height"
  v="5.0"/>
```

Parameters

- **v**: value

**<draw>**

Draw the animation. If it does not exists, then an error message is shown. Within this tag we can include new objects and move them using OpenGL transformations.

Syntax:

```
<draw
  min_delta_t="10"
  t_max="20"
  animate="0"
  delta_t="0.1"/>
```

Parameters:

- **t_max**: The total time for the animation.
- **min_delta_t**: Minimum time step between screen refreshes in the animation.

**<use>**

Include objects into the scene.

Syntax:

```
<use xlink:href="#free"/>
```

Parameters

- **xlink:href**: object name to be included. Must be the same as in the <geom_part> tag.

**<g>**

Make OpenGL transformations.

Syntax:

- **animate**: To animate automatically.
- **tc**: It is the computer time.
- **t**: It is the real time clock.
Define and couple the animation parameters. Furthermore, its own GUI is created automatically at the left side of the screen to allow to choose some features after loading an animation.

Syntax:

```
<blockdata n='animation' pn='Animation'>
  <value n='rotate_blades' pn='Rotate blades' v='1' values='0,1'>
    <dependencies node='/*draw/gl[@id='rotate_blades']'>
      <dependencies node='/*draw/gl[@id='rotate_blades']'>
        <dependencies att1='transform' v1='rotate(180.0*$t,0,0,1)' value='1'/>
      </dependencies>
    </dependencies>
  </value>
</blockdata>
```

Parameters:

- **n**: Internal name.
- **pn**: Shownname.

- **value/values**: Actions to be done depending on the selection.

- **dependencies**: Update the selected animation v variable.

### Annex I: Animation template file example

A complete animation template file example is presented, as follows:

**XML Header**

```xml
<?xml version="1.0" encoding="utf-8"?>
<param_creator version='1.0' xmlns:xlink="http://www.w3.org/1999/xlink">
<title>Semisubmerged platform</title>
</param_creator>
```

**Includes**

```xml
<include xlink:href="TLP_2_1m.post" type="gid_result" create_geom_parts="1"/>
<include xlink:href="estructura_TLP_2_1m.post" type="gid_result" create_geom_parts="0"/>
<include xlink:href="TLP_2_1m.BodyMovements.res" type="tabular_data" variable="delta"/>
```

**Geometry parts**

```xml
<geom_part n="free" pn="free" source="mesh,Free surface Auto1" color="blue"/>
<geom_part n="structure" pn="structure" source="mesh,Estructura" color="green"/>
```

**Draw objects and location**

```xml
<draw min_delta_t="150" delta_t="1.5" animate="0" debug="0">
<variable n="Surge" v="[m::linear_interpolate_value $tc [lindex $delta 0] [lindex $delta 1]]"/>
<variable n="Sway" v="[m::linear_interpolate_value $tc [lindex $delta 0] [lindex $delta 2]]"/>
<variable n="Heave" v="[m::linear_interpolate_value $tc [lindex $delta 0] [lindex $delta 3]]"/>
<variable n="Roll" v="[m::linear_interpolate_value $tc [lindex $delta 0] [lindex $delta 4]]"/>
<variable n="Pitch" v="[m::linear_interpolate_value $tc [lindex $delta 0] [lindex $delta 5]]"/>
```

```xml
<variable n="rad2deg" v="[m::linear_interpolate_value $tc [lindex $delta 0] [lindex $delta 6]]"/>
<variable n="Yaw" v="[m::linear_interpolate_value $tc [lindex $delta 0] [lindex $delta 6]]"/>
```

```xml
<draw min_delta_t="150" delta_t="1.5" animate="0" debug="0">
<variable n="rad2deg" v="57.2957795131"/>
```

```xml
<use xlink:href="#free"/>
```

```xml
<g transform="translate($Surge,$Sway,$Heave)">
<g transform="translate(0,0,-2.4)"
```
GUI options

In this example all the meshes are displayed, but it is possible to activate/deactivate appropriate meshes. For instance, in the image of below the mesh 'Outlet Auto1' has been deactivated:

It is possible to change the surface color and change it (i.e. to blue color), more close to the reality.

Annex II: About the postprocess results file

Once a model is calculated, a post process results file is created inside the model, in the same directory than the working model. This file is very important in order to create animations. In fact, it contains all the results calculated. If this file has not been created successfully, it is possible to export it in the " menu option. In this way, a post process results file with .post format will be created, which is usually required to be loaded by the animation creation tool.

Files ► Export ► Postprocess file

Annex III: Half-submerged platform

In this example the animation will be created entirely in the post process. After loading the model going to the post process, the post process GUI will be similar than the image of below:

The appearance with color blue is as follows,
The next step is to deform the free surface with the calculated results. Thus, the check-box 'Draw' should be activated in the 'Preferences/Deformed' menu. There are 2 possibilities:

- Real deformation: This deformation is real, the 'Adimensional Factor' must be unchecked.
- Adimensional deformation: This deformation does not fit with reality. The boolean checkbox 'Adimensional Factor' must be checked. If the ‘Factor’ parameter is equal to 1, then the program will choose an automatic deformation to try to show a good visualization.

The last step is to play the animation created, therefore play button allows to start the animation:

Annex IV: Multi-Bodies animations

In this annex, it will be shown how to create animations when dealing with SeaFEM simulation which involve multi-bodies analyses.

An example model will be used for explaining the different steps:

7. First thing to do is to create and export a mesh of each full body involved in the analysis and the animations. This mesh should include the whole body (under and above water geometry).

For exporting each mesh:

Files ➤ Export ➤ RamSeries mesh

In this example, with two bodies, two corresponding meshes have been exported and saved (mesh_body1.msh and mesh_body2.msh).

8. Next step is to go to post-process in the simulated model, and load the corresponding animation tool. In this case:

Postprocess ➤ Computer animations ➤ Seakeeping animations - 2Bodies

9. In the previous window, you can insert the corresponding mesh files (the ones exported before), together with the corresponding body movements file.

10. Once this is done, the floating bodies meshes get inserted, and dynamic behaviour can be plotted and recorded.

1.2.12. Compose reactions

Menu:

Postprocess ➤ Compose reactions

This command is available for structural model. It calculates total reactions in a model. When this menu option is selected, the following window is opened:
If all nodes are selected, then a list of them is shown:

If List result is selected, then all reactions and their sum is shown:

1.2.13. Laminates

Menu:
Postprocess ➤ Laminates

The "Laminates" option in the Postprocess menu gives access to the laminates results postprocess window. This is intended to compute on user's demand the stress, strain and security factor results for each ply of the laminate.

The user can select any layer (either starting from the top or from the bottom of the laminate) and ask for a variety of available results that are immediately computed on the entire mesh. After calculation of the new result, this is added to the results panel and is further treated as any other standard result. The list of available results is as follows:
Max. failure index Tsai-Wu (Complete) : Tsai-Wu maximum failure index (FI) for the selected layer. The largest value is taken between the top or bottom of the layer, resulting in the most conservative criteria.
- Security coef. Tsai-Wu (Complete) : Tsai-Wu failure index (FI) at the midplane of the layer.
- Security coef. Tsai-Wu (Simple) : Tsai-Wu reserve factor (RF) at the midplane of the layer.
- Security coef. LaRC04_r : LaRC04 reserve factor at the midplane of the layer.
- Security coef. LaRC04_m : LaRC04 reserve factor at the midplane of the layer.
- Layer stress/strain : stress/strain at the midplane of the selected layer.
- Layer stress/strain : stress/strain at the midplane of the selected layer.
- Layer stress/strain : stress/strain at the top of the layer.
- Layer stress/strain : stress/strain at the bottom of the layer.
- Layer shear stress/strain : shear stress/strain at the midplane of the layer.
- Layer shear stress/strain : shear stress/strain at the midplane of the layer.

As an example, in the figure below it can be observed how the reserve factors were computed for each of the four layers of a simple laminate shell. It can be appreciated on the right that all the newly computed results are added to the results panel for further user’s analysis.

1.3. File menu

1.3.1. Save

Menu:
File ➤ Save

Toolbar: ![File Menu](File.png)

This option saves the elements created in Postprocess as information boxes, meshes (cut plane, copies of meshes, etc), flow patterns, if results file has been created in Binary2 format.

1.3.2. Import

Menu:
File ➤ Import

This menu option allows to import a post process results file (*.post, *.msh, *.res) in both standard post process format and ASCII format. It also permits to import a batch file (*.bch).

1.3.3. Export

Menu:

File ➤ Export

This menu option includes some commands that export postprocess results and meshes to files in different formats.
- Export results and meshes are stored in standard format. It is important to note that the files stored in standard format could not be read by the traditional postprocess.
- Export results and meshes are saved to ASCII format. They are stored in a file (*.msh).
- Export meshes and results are exported to ASCII format. Meshes are stored in a file (*.msh) and results in another file (*.res).
- Meshes and results exported to ASCII format can be read by traditional post process.

File ➤ Export ➤ ASCII postprocess ➤ Files

1.4. Special features

- The contextual menu contains specific commands depending on the under-laying objects.
- Easy selection of the units for the active result.
- In order to work with a specific tool (animation control, meshes selector, etc.), it is possible to set the integrated pane hiding easily the other tools available.
- Every pane for animations, meshes, results or preferences can be expanded or contracted. If contracted, then it is opened like a menu-button.
- It is possible to create a new mesh by selecting some elements of existing meshes.
When creating the new mesh, it is possible to apply a translation or symmetry to the nodes.

- List of nodes, elements and results, with the possibility of displaying them in the graphical screen.
- Objects like vectors, main axes and local axes are drawn at a given density, avoiding to draw them on every node or element.
- Option to draw the boundary conditions symbols.
- It can read the results data from disk or recalculate it on demand. Only a few results data are kept in memory.
- It can save all data on a file taking care of not rewriting the already written parts. Data is saved with the model or exported to a external file.
- It allows full undo/redo operations.
- It allows to create sophisticated animations by using an XML-file and an automatic creator form.